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Welcome to Revo Scan b!

Revo Scan 5 is your essential scanning and editing companion for all Revopoint
3D scanners. In Revo Scan 5, you can do a 3D scan to create point clouds, then
process and edit the data into 3D models or processed point clouds that are
ready to be exported for use elsewhere in your workflow.

This manual covers every setting and function in Revo Scan 5 and teaches you
how to get your first 3D scan.

Read Before Using

* This manual covers Revo Scan 5 (PC) operations for Windows and macOS
devices. To learn more about Revo Scan 5 (Mobile), please check their
respective manuals in the iOS or Android Revo Scan apps.

* If you're entirely new to 3D scanning, to get the most out of this guide, it's
recommended to first refer to the glossary and familiarize yourself with any
new terms.

* Keep your version of Revo Scan up-to-date for the best user experience.

* Software updates may alter Revo Scan’s Ul. Please refer to the actual layout in
Revo Scan. While we'll try our best to keep this manual up to date, some things
may slip through. If it isn't in the manual, please ask in our forums.
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1. Installing Revo Scan
1.1Recommended System Requirements

To use a Revopoint 3D scanner, you need a computer that meets the
recommended requirements.

System Minimum Recommended

. Windows: Win 10/11 (64-bit) Windows: Win 10/11 (64-bit)
. RAM: 2 16GB RAM: 2 32GB
CPU: Intel i7 12th gen or better | CPU: Intel i9 11th gen or better

Ay

p Mac: macOS 11.0 or later Mac: macOS 11.0 or later
G RAM: > 8GB RAM: > 8GB
— CPU: M1 Pro or better CPU: M3 or better

1.2 Installation Process

For Windows and macOs, visit Revopoint's website
revopoint3d.com/pages/support-download to download your system's latest
version of Revo Scan 5.

1.2.1 Windows

Double-click the downloaded file and follow the installation wizard to install
Revo Scan 5. Once finished, double-click the Revo Scan 5 icon to open it.

1.2.2 macOS

In Finder on your Mac, locate the download of Revo Scan, right-click it, go to
Open With, and click Installer, then follow the installation wizard. Once finished,
double-click the Revo Scan 5 icon to open it.

Note: You may need to enable your Mac to install non-App store software.

Go to the Apple menu > System Settings, click Privacy & Security in the sidebar, then go to
Security on the right. (You may need to scroll down.) Change the security setting to "App
Store and identified developers”.
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2. Interface Overview

2.1 Home Page

New Project

@ Home ]
#® New Project

[0 Learning Scanner Settings &}

@) Contact Us

Project (59) Project List
Navigation Pane -

Name 11 Last Modified =}

Project04232024171601 10/24/24 11:30 AM 296.94MB
Project05232024141108 10/24/24 11:29 AM 662.01MB

Project04032024171632 10/24/24 11:29 AM 451.16MB
Revo Scan 5 Tutorial

Project04232024192055 10/23/24 5:25PM 270.01MB

< >

0O 1. Project09292024101950 10/23/2411:17 AM 502.56MB

o ) Calibrati Merging 10/23/24 11:09 AM 397.91MB
€ Scanner Calibration

Project09202024162034 10/22/24 6:51 PM 17.17MB

*The software's user interface is frequently updated and varies depending on the connected 3D scanner. Please refer to
the actual layout in Revo Scan.

2.2 Project Interface

2B File Display Accessories Help Project11012024095337 Project Title
. 5 t
- i Menu Ba . R R a
@) Global Mar Tab Bar

Scan Point Cloud Edit Mesh Edit

Exposure O Start/Pause Scan: Space
Cancel: ESC .
() s e Click "Start" to scan cor &y rocor [ Scanning Controls

X > B v

Depth- RGB- Depth+

Cancel Start Complete

103N 00}

Scan Settings L

Depth Camera » )
4 High Accuracy v
i Scan Settings

Feature Tracking .

9)10x3

Depth Camera

3 General

Central Preview Window
T i z

Exposure  AWB
Color Scanning

Scanning Distance Indicator Bar

[Auto ]

Scanning Distance (mm)

150 400

5‘, — —
) : ‘

E -
Frames: ()
RGB Camera 5
p

~€* USB Connected

Instructions
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3. Settings

3.1 Scanner Settings

When a scanner is connected, click the
settings icon on the Homepage scanner
pane to access the scanner's settings.

Scanner Connected &

3.1.1 Basic Details

® Scanner Info

Scanner Settings

See the scanner's type and serial number.
® IMU Calibration

The IMU sensor measures the scanner's
acceleration, rotation, and orientation. Calibrating
the IMU ensures the scanner tracks its movement
data accurately, resulting in better frame stitching
and scanning accuracy.

Click the “Start Calibration” button and follow the
onscreen instructions to complete the calibration
process. IMU calibration only needs to be done
Update when prompted by Revo Scan 5.

Basic Details Wi-Fi Settings

About

Note: This option will only appear if the connected
scanner has an IMU.

Cancel Confirm

® Firmware Version

An “Update” button will be displayed when a new firmware version is available.
Tap the button and follow the instructions to update.

3.1.2 Wi-Fi Settings

Scanner Settings

Scanner Settings

Basic Details Wi-Fi Settings Basic Details Wi-Fi Settings

12345678

Cancel Confirm

Cancel Confirm
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Host Client

Connect a scanner to a PC via the | Connect a scanner to a PC via a Wi-Fi
scanner’'s Wi-Fi. The PC will lose | network. Keeps your PC connected to
internet access via Wi-Fi. the internet.

What's the
difference?

. " .| Enter your Wi-Fi network's name
Find the "Scanner Name-REVO X

. ~~ |(sSID) and password, then click
Wi-Fi network and connect to it in .
How to confirm.

your PC's Wi-Fi settings. .
connect? Ensure the PC is on the same network,
Open Revo Scan, and the scanner
open Revo Scan and the scanner

should connect after a while. .
should connect after a while.

1. You can change the scanner’s
SSID name and set a password.

If the scanner fails to connect over
Wi-Fi, check that its region matches
your country.

2. Remember to memorize the
password if you enable it, or this will
prevent you from using Wi-Fi.

Client mode is only recommended if
you have a stable 5GHz network.

For best performance, ensure the
scanner, PC, and Wi-Fi router are all
close to each other.

Notes

3.2 Revo Scan Settings

Access Revo Scan’'s settings by clicking the
setting icon on the Homepage in the top right ® New Project
corner.

Default File Location: Select the default file
location to store projects and models.

Settings

Defauit il Location _ Screenshots Default Folder: Select the

| D:/Revo Scan Model Change

default file location to store screenshots.

Screenshots Default Folder

| DiRevo scan Hodel "l Language: Select your preferred language.

Language Project naming pop-up: Untick the box to
= @ turn off the naming projects pop-up when
# Project naming pop-up (D Cre(]ting G neW project.

Y ———— GPU-accelerated rendering: Enable/disable
GPU-accelerated rendering. (If your PC
Cancel save doesn't have a GPU, it's recommended that
you disable it for a more stable experience.)
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4. Software Functions

4.1 Scanning
4.1.1 Scanning Controls

Cancel button: Click it to delete all captured
data.

start/Pause button: Click it to start or pause the
Scan Settings scan.

Complete button: Click it when the scan is
finished to move on to the editing process.

2
ol
2
o

Scanning Distance Indicator Bar: This shows if
the distance between the scanner and the object
is optimal for the best-point cloud capturing
e results. The indicator bar will show green when an
optimal distance is reached.

Scanning Distance (mm) &

e Undo/Redo buttons: While paused, the Redo and
b Undo buttons can remove or add back scan
Instructions data. This can be done repeatedly.

4.1.2 Scan Settings

Before starting a scan, selecting the correct settings for the object being
scanned is essential for the best results.

Capture Modes

Change capture modes by clicking the drop-down menu on the Start/Pause
button.

Cancel [ Corirans Complete
@ Single Shot
Scan Setti
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® Continuous

- The scanner captures multiple frames per second (fps) in continuous mode.
Use Continuous mode to capture objects quickly.
Note: Maximum fps is determined by the scanner’s model.

® Single-shot

* In single-shot mode, the scanner captures one point cloud frame each time
the button is pressed in Revo Scan or on the scanner.

* This mode is useful when capturing objects with sharply contrasting color
surfaces or in hard-to-maneuver spaces.

* Each frame needs at least 50% overlap to successfully align into the model in
single-shot mode.

Correct overlap Wrong overlap

Accuracy

Scan Settings

High Accuracy
+ High Aceuracy

Standard Accuracy

High-speed (16 fps)

« Standard Accuracy: For capturing simple objects that don't have complex
and detailed surfaces.

* High Accuracy: For capturing highly detailed objects.
- High-speed: For capturing larger objects or people/body parts quickly with
faster frame rates and smooth frame stitching.

Note: Accuracy settings available, scanner speed, and size of the object capable of being
captured are dependent on the scanner’s model.
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Tracking Mode
Scan Settings

High Accuracy

Feature Tracking
~ Feature Tracking

Marker Tracking

Global Marker Tracking

* Feature Tracking: For objects with distinct surface features and no repeating
patterns.

* Marker Tracking: For capturing large flat surfaces that don’t have distinct
details. It must be used with marker points for tracking aids.

- Global Marker Tracking: For capturing larger featureless objects. There are
two steps: First, capture the markers to generate a global marker file. Second,
scan the point cloud based on the global marker file.

Object Type

Feature Tracking

General

+/ General

Dark

* General: This is the standard object type. Pick this type if the object doesn't
match the other options below.

* Dark: Scan objects with dark surfaces, such as black or dark gray clothes.

Some dark items, such as black leather or metal surfaces, which will absorb or
reflect light, may still need to be treated with scanning spray to make them
scannable.

* Face: Scan people’s faces.
* Body: Scan people.
* Large: Scan larger objects quickly. Only available for certain scanners in High-

speed accuracy mode.
Note: Available object types and the captured object’s size depend on the scanner’s model.
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Color Scanning

General

Color Scannir

Base Removal ®

Enable it to capture color data using the scanner’'s RGB camera.

When performing a color scan, ensure the object is evenly lit with soft light for
optimal color capture results.

Note: Texture mapping can be applied only when Color Scanning is enabled.

Base Removal

Base Removal &

Scanning Distance (mm) &

Toggle it on to enable automatic deletion of any unwanted flat surfaces
detected (e.g., a table or floor). If scanning an object with many flat surfaces,
turn this off to avoid deleting any of the object’s surfaces.

Scanning Distance
Base Removal &

Scanning Distance (mm) ©®

120

Use the slider to adjust the Depth Cameras’ working distance to ignore
unwanted background or foreground objects. Both a minimum and maximum
distance can be set.

Note: Within the same project, if the distance is set for the first scan, it will be automatically
saved for subsequent scans.
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Depth Cameras

Adjusting the depth cameras’ exposure before starting a scan is crucial to
getting a good 3D model.

* Adjusting Exposure

Exposure

The depth cameras’ exposure can either be

[otq | [r— 1 set to auto-exposure or manually adjusted.
' Adjust the exposure slider until there are as

few blue and red patches on the object as
possible in the Depth Camera window.

Ix  15x Underexposed Correct Exposure  Overexposed

The exposure may need to be adjusted mid-

Depth Camera . .
scan depending on the properties of the

surface being captured.
* Digital Zoom

When capturing smaller objects, the Depth Cameras’ up to x2 digital zoom
makes it easier to focus the scanner so it only captures the object's surface
data.

Depth Camera DepthCamera
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RBG Camera

To capture an object’s color accurately during a scan, please ensure it is evenly
lit with soft light, and the RGB camera’s exposure and white balance have been
adjusted.

* Adjusting Exposure

Exposure AWB

Adjust the exposure until the colors look accurate
[ Auto | in the RGB camera preview window, or set it to
auto.

.I*]i

Underexposed Correct Exposure Overexposed

* White Balance

Either set the white balance to auto or adjust it till

RGB Camera
the colors look accurate.

e Flash LEDs

Toggle On/Off the RGB Camera’s Flash LEDs to enhance color scans or help to
make marker points more visible while performing a scan using Marker Tracking.
(Only for scanners with Flash LEDs)

Scan settings can be saved and imported when performing another scan.
Saving Scanning Settings

Set the scan’s settings » In the File menu, click Save Scan Settings > Name the
setting and choose a location to save it.

Importing Scanning Settings

In the File menu, click Import Scan Settings > Select the file containing the

wanted setting and click open.
Note: Only the scanning settings for the currently connected scanner can be imported.
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4.2 Model Editing

The initial unprocessed raw point cloud from the scan is a collection of
individual data sets or frames. It must be fused, meshed and textured (optionql)
to make it a high-quality 3D model. This can be done by using either One-click
Edit or manually editing the raw data.

4.2.1 One-click Edit

Revo Scan 5 has a powerful one-click processing feature that automatically
performs fusion, meshing, and texturing (if a color scan was done) based on the
best detected setting for the point cloud.

Note: For new users, the “One-Click Edit” function is recommended for the first few scans.

Tap the “Apply” button to perform the “One-Click Edit” function. Click the “Cancel”
button to cancel the process.

QP Giobal Mar- Oneclick- Fusion
Scan Point Cloud Edit Mesh Edit

Model Batch Processing (2 int: Alt + Left-Click : % One-click Edit

dove: Shift + Left-Drag
- Color @ NoColor i "o . )
y Fusion: 0.10 {mm)

e
9.13_pc
dw 922-P Rendering Mesh: 5.30

sxe 0428_01

Properties (D

Model Name: 0428_01
Scanner: MINI2

ABHOOABS

ontinuous

Scan Settin High Accuracy-Feature
Tracking-General

~€* USB Connected

After the model is post-processed, you can manually edit it further if needed.

4.2.2 Manual Edit

In Manual editing, you can fully edit your raw point cloud data during every step
of the process or edit imported 3D models from other sources.

4.2.2.1 Point Cloud Fusion

Fusion is fusing the raw scan data captured by the scanner into a unified point
cloud model. There are two fusion methods:
® Standard Fusion

It processes data fast and is better for processing large data scans with many
frames.
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® Advanced Fusion

It produces a high-quality point cloud but spends more time. It is suitable for
scans with high detail requirement.

Point Distance

Point Distance is the average distance between adjacent points in a fused point
cloud. Revo Scan will suggest an optimal point distance for each scan to
optimize details and file size, but different values can be specified depending on
your requirements.

Note: Despite having a higher minimum point distance than Standard Fusion, Advanced
Fusion will produce a more detailed model due to more advanced algorithms.

Suggested Settings

* Set a lower point distance for objects that have a lot of detail.

* Set a higher point distance for objects with many flat featureless surfaces.

Note: To merge two point clouds successfully, set the two models’ point distance as close
as possible. See the merging section of this manual for more details.

Tap the “Apply” button to perform the “Fusion” function. Click the “Cancel”
button to cancel the process.

»oFusion

Fusion

Fusing Method
© advanced
() Standard

Point Distance (mm) < Estimated time 2 minutes

4.2.2.2 Point Cloud Editing Tools

Isolation Overla--- Smooth Simplify

Point Cloud Edit

Use these tools to remove unwanted data and refine your point cloud before
either exporting or meshing the data. The Undo/Redo buttons can undo or redo
multiple processing steps.

® |Isolation

Detects and removes the isolated point cloud data
disconnected from the main point cloud model (see the
red area in the figure).

The isolation rate: The percentage of points within
isolated point clouds relative to the total number of
points. Setting higher isolation rates results in more
isolated point clouds being detected.
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® Overlap Detection

Identifies and deletes overlapping data in the point
cloud for a more consistent model. It can be used
repeatedly to simplify point cloud data.

Vertical Distance: The distance between the
overlapped point cloud noise and the captured surface
area. If it's less than the set value, it's considered noise
and removed. If it exceeds the set value, it's not
removed.

® Smooth

Removes noise from the oint cloud to make it smoother.

To use it, select its strength and the number of times it applies smoothing
consecutively.

Note: For feature-rich models, excessive smoothing may result in loss of details (see the
figure below).

Before After

® Simplify

Reduces the density of the point cloud and the amount of data for more
manageable processing, storage and sharing. There are two different
downsampling methods:

* Uniform

Removes the set percentage of points across the model evenly.

* Geometric

Intelligently identifies flat or plain surfaces in the point cloud and will remove the
set percentage of points from these areas while leaving more complex areas
alone to maintain the details.

Ratio: The percentage of simpilified point cloud data to the total amount of data.
Setting a higher ratio will delete more point cloud data from the model.

Note: Selecting a ratio that is too large may impact the model's quality.
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Properties () ’ Properties (D

Model Name: 0428_01 { Model Name: 0428 01

Scanner: MINI2 | y Scanner: MINI2

SN: A23A06685A6H00ABS SN: A23A06685A6H00ABS
Rendering State: Fused ‘ Rendering State: Fused

Points: 632755 ; Points:

Model Type : Continuous Model Type : Continuous

Scan Settings: High Accuracy-Feature & Scan Settings: High Accuracy-Feature
Tracking-General Object Tracking-General Object

Unsimplified Simplified
4.2.2.3 Meshing
Mesh is created by constructing triangles from the points in the point cloud to
create a solid surface. Before being used in most 3D modeling or slicing
software, the point cloud must be meshed.
* Quailty
The mesh model’s density and level of detail. Settings a higher value results in a
denser and more detailed mesh model but spends more time.
» Suggested Settings
Set a higher mesh quality if the object has a lot of fine details.
Set a lower mesh quality for objects with many flat, featureless surfaces.
« Hole Filling (Auto) Tool
Revo Scan automatically identifies and fills all the holes on the mesh model.
Ratio: The percentage of the hole diameter to the overall mesh size. The holes
smaller than this ratio will be filled.

Note: Trying to fill large holes may result in a distorted surface. Use the Fill Holes tool in the
mesh editing tab to fill larger holes.

Tap the “Apply” button to perform the “Mesh” function.

Hole Filling (Auto)

4.2.2.4 Mesh Editing Tools

¥ L]

Isolation Fill Holes Smooth  Simplify

Mesh Edit
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® Isolation

Detects and removes the isolated mesh data
disconnected from the main mesh (see the red area
in the figure).

Isolation Rate: The percentage of an isolated mesh
relative to the total number of meshes. Setting a
higher value will detect more isolated mesh data.

® Fill Holes

Detects all holes on the model's surface. Select the holes and fill them with a
plane or curved surface. If needed, use Ctrl + A to select all the holes quickly.

Before (Hole Filling) After (Hole Filling)

® Smooth

Removes noise from the mesh model to make it smoother.

To use it, select its strength and the number of times it applies smoothing
consecutively.

® Simplify

Reduces the amount of mesh data in the model for more manageable
processing, storage and sharing.

Ratio: The percentage of simplified mesh data to the total data volum. Setting a
higher ratio will remove more details, resulting in a smaller file size.

Properties (9 Propertie

Model Name: 0401_04 - Model Name: 0401_04
Scanner: POP3 L , Scanner. POP3

SN: A23B0549266H02A85 SN: A23B0549266H02A85

Rendering State: Meshed Rendering State: Meshed

Vertices: 240481 ¢ Vertices: 144273
olygons: 480531

Model Type : Continuous

Scan Settings: High Accuracy-Feature - 2 s: High Accuracy-Feature
Tracking-General Object Tracking-General Object
Unsimplified simplified
4.2.2.5 Texture

Texture is applying the color data captured by the RGB camera to the mesh to
create a high-quality colored 3D model. There are two texturing methods:
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® Colorimage

This method maps the image data captured by the scanner's RGB Camera on
the mesh’s surface to create a colored model.

® Vertex Coloring
This method generates textures from the mesh's vertices color.

Tap the “Apply” button to perform the “Texture” function. Click the “Cancel”
button to cancel the process.

a lexture Mapping
Creating a texture

Texture
© colorimage

Estimated time 2 minutes
() Vertex coloring

Apply

4.2.2.6 Model Merging

The merging function supports the alignment of multiple scans in a project into
a new model. Please note that the scans can only be merged after they are
fused. There are two alignment methods: Feature and Manual.

® Feature Alignment

Select the models, and Revo Scan will automatically merge them by identifying
and aligning the overlapping features in multiple models.

The overlapping area between any two models should be more than 10% (for
best results, 40% to 50% is recommended). Up to 9 fused models can be
selected and merged simultaneously.

® Manual Alignment

At least 3 reference points must be manually placed in matching locations on
each model. Then, Revo Scan merge the two models by identifying and aligning
the reference points. Only 2 models can be merged at a time.

+ The number of corresponding reference points on both models must be the
same.

+ Avoid grouping the markers together in a small area.
« Zoom in on the features of each model to place the marker points carefully.
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? % “ .
- Global Mar--- One-click -+ Fusion Isolation Overla-- Smooth Simplify Mesh

Scan Point Cloud Edit

Model Deselect X

& 0321 02 [ |

FOR k!
Model2: 0327_01

y )

No 3D scannerwas found.

4.2.3 Key Frames Editing

v

Isolation Fill Holes

Mesh Edit

1

v

- a

Smooth  Simplify Texture Merge Export

4 Merge

) Feature
© Manual alignment

& Clear markers

Generate Model

Instructions

Use it to edit or delete the raw data before fusion. This tool can be used to go
through captured point cloud data frame-by-frame and quickly find the

misaligned or faulty frame for deletion.

Go to the project panel and click the ﬂzﬂ

icon or click the ee« icon > Key Frames

Edit to enter the Key Frames Edit
interface. There are two methods to edit
the key frames:

Model

A 03001

A 0129 01

Batch Processing (&)

3 S

Delete All Edits

Key Frames Edit
Continue Scanning (@
Rename

Delete

1) Clickthe [ » ] button to autoplay through the frames individually. Then, select
any unwanted frames and click the = button next to each frame’s name.
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- 33 & & 5 =

\ &
QY| Gicbal Mar- Oneclick-- Fusion Isolation Overla- Smooth Simplify

Scan Point Cloud Edit

< 0929_02 nt: Alt + Left-Click
Shift + Left-Drag

(4 Edit all key frames Space

Show only selected key frames

frame_557
frame_559
frame 561
frame_563
frame_ 565
frame 567

frama RRQ

No 3D scanner was found.

— A A a & v

Isolation Fill Holes Smooth Simplify Texture Merge Export

Mesh Edit

Color ‘ No Color

Rendering

2) Enter the Key Frames Edit interface, use any selection tool in the Tool Bar to
select the unwanted data. The corresponding frames will be automatically
identified and selected. Click the (= button or the button to delete all the

faulty frames.

) y 2
WP CGlobalMar One-click - Eusion | Isolation: Overla= Erooth Simpliy

Scan Point Cloud Edit

< 0929_02 otation: Ctrl + Left-Drag

Show only selected key frames

|

frame_378
frame_380
frame_382
frame 384

frame_386

frame_388

frama 200

No 3D scanner was found.

4.2.4 Toolbar

! & 9 B &

Isolation Fill Holes Smooth  Simplify Texture Merge Export

Mesh Edit

Color @ NoColor @

Rendering

The Tool Bar provides multiple tools that enable users to select unwanted local
data for detailed editing or deletion manually.

Note: The Tool Bar can’t be used for raw data or textured models.

Orbit

Rotate the view in any direction. Clicking it will also de-select any previously

selected areas.
@ Rectangular Selection
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Click and hold the left mouse button to draw a rectangle around any point on
the model to select that area.

Polygon Selection

Left-click to create anchor points to select a mesh's polygons (faces). The
Polygon tool creates a straight line between each Anchor Point. Click on any
edge of the area to be selected and release the mouse pointer to make an
Anchor Point.

Lasso Selection

Click and hold the left mouse button, then draw a shape around an area to
select it. Release the mouse button, and the selection will be closed by
connecting the current pointer location to the start location with a line.

Select Connection

Left-click on a data areaq, and the tool will automatically select the adjacent or
connected points or areas.

Clip

Position the cursor, click and hold the left mouse button, and drag. The clipping
plane will appear as a line. The portion of the model in the direction of the line's
arrow will be selected. Press <Delete> to apply the change, <Esc> to cancel.

Invert Selection

Use the invert selection button to change the selected area from the currently
selected area to anything that wasn't selected.

Delete

Click to remove the selected data. Alternatively, use your keyboard’'s delete
button.

Select Through
Enable it to select data right through the model.
. Smooth Brush

Place the cursor over a rough area (e.g., marker holes), then left-click or left-
click and drag to smooth.

[«)/[#] undo/Redo

Use to roll back or re-add changes made to the model.
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4.3 Model & Project Management
4.3.1 Display Options

Display options can be accessed in the Display section in the menu bar.
Zoom to Fit

Click to reset the zoom to its original position so the 3D model is fully visible on
the screen.

Default Position

Shows the 3D model from a viewpoint determined by the first few frames
captured.

Perspective View

The camera is positioned at a fixed point in space, so the model has a sense of
depth and distance. This is the default view.

Orthogonal View

All objects appear at the same scale, and all three dimensions (width, height,
and depth) are projected onto a 2D plane to preserve their relative sizes and
positions.

Show Bounding Box

Displays or hides the bounding box around the current model. The bounding box
is a rectangular box that is wrapped as tightly as possible around the object.

Show Rotation Ball
Displays the XYZ rotation axis to show the model's orientation in 3D space.
Show Grid

Displays or hides a virtual 3D grid in the editing interface. The grid is a structure
of horizontal and vertical lines that help to position and align objects.

Show Scanning Location

Displays location references for color scans captured in Single-shot mode. Use it
to see if any color data needs to be reshot. Click on any reference to view a
single frame captured at the current position; double-click on a reference to
view the model image captured at the current position.

Show Reverse Point

Shows or hides the surface across from the current one in another color (brown
or transparent).

Mesh Model Display

* Solid: Turn the model’'s surface on or off.

* Wireframe: Shows the model’s wireframe.

» Wireframe Overlay: Shows the model's wireframe overlay.
Model Properties
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Click Model Properties to change the model’s color and surface properties.
Enable Select Through

Enable it to select data right through the model.

Screenshots

* Full Screen: Capture the entire screen

* Model Only: Only captures an image of the 3D model.

Light Source

Drag the icon to adjust the Light Source's position. Double-click the icon to reset
to the default location. Click off the icon to close.

4.3.2 Model Management

s o L]
- Global Mar--- One-click - Fusion Isolation Overla---

Scan Point Cloud Edit

Model Batch Process S oint: Alt+ L

& o023 01 B

Delete All Edits

Key Frames Edit

@
Rename
Delete

If you've created a project with multiple scans, batch processing can perform
the Fusion or Meshing processes with the same settings on multiple models.

Batch Processing

Click the batch process button. Select the models to be processed. Select a
setting for Fusion or Mesh and click Apply.

Exporting Models

There are two methods of exporting models:

« Open a Project » On the Project Management panel, click the More icon next to
the model's name > Click Export and select the state to export > Select the file
destination and format.

« Open a Project » On the Project Management panel, click on a Model > In the
Tab Bar, Click Export and select the state > Select the file destination and format.

Note: Selectable file formats depend on the model state being exported.
Delete All Edits
It deletes all the edits and resets the model to being unprocessed raw data.

Renaming/Deleting Models

2]
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Double-click the model on the Project Pane to rename it. Or click the More icon
next to the model’s name and select Rename or Delete.

Importing Models

Open a project or create a new project > In the File Menu, go to Import > Select
the model and click Open.

4.3.3 Project Management

Creating New Projects

There are three methods of creating new projects:

- On the Homepage (connected scanner) > Click the New Project pane or
Scanner Connection Status pane.

« Click the button between the Home and Open Project buttons in the Menu
Bar.

* In the project interface > In the File Menu, go to New Project and Click.
Opening a Project
There are two methods of opening a project:
+ On the Homepages’ Project list > Double-click a project.
* In the project interface, go to Menu Bar, and click File > Open a Project or
Open Recent Projects.

Opening the folder

In the project interface, go to the Menu Bar and click File > Open Folder to open
the folder where the current model is located.

Saving Projects
When a project is open > In the File Menu, click Save.
Renaming Projects

On the Homepages’ Project section > Click the More icon on the project's
thumbnail > Click Rename.

Deleting Projects

* Deleting Individual Projects

On the Homepages’ Project section > Click the More icon on the project's
thumbnail > Click Delete.

* Deleting Multiple Projects

On the Homepages’ Project section > Click the tick box next to one or more
project thumbnails > Click Delete.

Importing Projects
* Revo Scan (Mobile) to Revo Scan (PC)
1) Ensure the phone and PC are connected to the same Wi-Fi network.
22
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2) Open Revo Scan (PC) and click the New Project button on the Homepage.

3) Click the Import from Phone option in Revo Scan (PC)’s File menu.
4) Pick either the PIN code or the QR code transfer method.
5) Open Revo Scan (Mobile) and find the project to be transferred.

6) Tap the More button »Share icon in Revo Scan (Mobile).
7) Enter the PIN code or scan the QR code.

8) Start the file transfer.

Note: Don’'t minimize the app or turn off the phone’s display during transfer, or it'll fail.

« MIRACO to Revo Scan (PC)

Transferring via Wi-Fi

Transferring via USB

1) Ensure MIRACO and PC are
connected to the same Wi-fi network.

1) Connect MIRACO to a PC using the
USB Type-C to C cable..

2) Open Revo Scan (PC) and click
Import from MIRACO > Wi-Fi in Revo
Scan (PC)’s File menu. Pick either the
PIN code or the QR code transfer
method.

2) Tap the Data Transfer button on the
popup window on MIRACO.

3) On MIRACO, tap the More button
next to the required files and tap the
Share Model icon.

3) Open Revo Scan (PC), wait for a

moment, and the project list in MIRACO
will appear.

4) Enter the PIN code or scan the QR
code shown in Revo Scan (PC) to start
the file transfer.

4) Select the required files and export to
your PC.

Note: Don't leave the transfer interface or turn off the MIRACO's display during transfer, or it'll

fail.

23
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5. First Scan

Let's do a scan with the small bust (not included with the RANGE series) that
came with your Revopoint 3D scanner.

5.1 Preparation
5.1.1 Connecting the Scanner (PC-USB)

Y/

£

1. Connect the scanner to a PC via the USB Type A to Type-C
cable.
Plug the USB Type-C end into the back of the scanner and
tighten the screw. Plug the USB Type-A end (or use the USB
Type-C to Type-A Adapter) into a PC.

2. Open Revo Scan on the PC and wait for the scanner to
appear.

5.1.2 Preparing the Scanning Environment

1. Clear the work area of any clutter and unnecessary items.

2. Place and power on the Mini turntable by connecting it to a
plug or USB port on a PC.

3. Place the bust in the center of the turntable and ensure the
bust is evenly lit but not in direct sunlight.

4. Adjust the scanner to aim at the object by setting a suitable
height and angle.
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5.2 Scanning Process
5.2.1 Creating a New Project

# New Project

1. Click the New Project.
2. Name the project, select a file location (or use the default

one), and then click New to enter the Project Interface.

Point Cloud Edit Mesh Edit

13.0 fpS £+ MINI 2

X > B v

: Space
Click "Start" toscan @ nocolor

Cancel Start Complete

~v

Scan Settings

= S High Accuracy

Depth Camera
Exposure  AWB

[Auto)

Feature Tracking

General

= s Color Scanning
A\
Frames: 0 Base Removal

RGB Camera

<> USB Connected

3. Center the bust in the depth camera preview window.
4. Adjust the distance between the scanner and the object
until the Scanning Distance Indicator in Revo Scan shows an

excellent distance.

5.2.2 Selecting Scan Setting

Point Cloud Edit

- Global Mar-++
\ Mesh Edit
13.2 fpS € MINI 2

X b = v/

Cancel Start Complete

Scan Settings
High Accuracy
Feature Tracking

General

Coloi

Frames: 0 Base Removal &

~£* USB Connected

1. Select High Accuracy, Feature, General, and toggle Color off

in the scan settings.
2. Adjust the Depth Cameras’ exposure or set it to auto.

25



Revo Scan 5 User Manual

5.2.3 Starting the Scan

X

Cancel Complete

1. Click the Start button to Start the scan.

x Il &

Cancel Pause Complete

2. Once the turntable has done one full rotation scan, pause it
to check the model.

If the model is incomplete, click the Start button to continue
the scan.

5.3 Finishing the Scan

Complete

Check the model and click the Complete button if it's ok.

5.4 Model Editing

%, One-<click Edit

usion: 0.31 (mm)

' Global Mar--- | One-click -+

Scan /
Model

Batch Processing (&1

Click on the One-click-editing button to process the point
cloud.

5.5 Model Exporting

Export

All Models

Point Clouds

Mesh Model

Click the Export button and Select the state > Select the file
destination and format.
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6. Help and Feedback
6.1 Scanning Tips

1) Scanning Different Object Types

® Scanning Feature-Rich Objects

Feature-rich objects are usually straightforward to capture as their detailed
surfaces have many distinct features for the scanner to track.

@ Select Feature Tracking mode.

@ Scan the object.

® Scanning Featureless Objects

N

‘/.

Successfully capturing symmetrical or flat featureless objects requires
preparation as they lack distinct features for the scanner to track. This can be
dealt with in several ways:

* Place Marker Points

@ Place marker points on the object's surface

g
¢
o W

) o/
° ® o
)

©

irregularly.

S

@ Select Marker Tracking or Global Marker L
Tracking in the Tracking Mode. =

3 Scan the object.

For different markers and scanners, follow the guidelines below:

Large markers (10 mm outer diameter) - for POP series, INSPIRE, RANGE series,
MIRACO (Far Mode)
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Place markers at a distance of 3-4 cm | 5 or more markers per frame. If using
the RANGE series or MIRACO (Far Mode), place markers at a distance of 6 - 8 cm
| 5 or more markers per frame.

small markers (6 mm outer diameter) - For MINI series, MIRACO (Near Mode)
Place markers at a distance of 1-2 cm | 5 or more markers per frame.

Note: If using scanning spray and markers, it's better to apply the scanning spray first and
then place the markers. This makes it slightly easier to remove the markers when it's done.

* Magic Mat

The Magic Mat can be placed underneath some objects for a fast sticker-free
marker point solution.

* Turntable Topper

Place the Turntable Topper on top of the turntable to provide pre-placed marker
points for objects with a surface area too small to place enough marker points.

<

Place feature-rich objects (like the small statue included with most Revopoint
3D scanners) around the object to be scanned. When setting up the scan, select
Feature Tracking Mode. The scanner will capture these along with the object
being scanned, and they can easily be removed in post-processing.

* Reference Objects
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e Black, Transparent, Metal or Shiny Surfaces

Surfaces with these properties can be challenging to scan as the surfaces will
absorb the light, reflect nothing, or reflect too much for the scanner to see
what's there.

These kinds of surfaces need to be made matte to deal with it. This can be done
in several ways:

@ Use scanning spray to lightly and evenly coat the object’s surface.

@ Use a fine powder like baby or makeup powder to lightly coat the object's
surface.

2) Outdoor Scanning

Direct sunlight should be avoided when scanning outdoors, as it can interfere
with the scanner's depth cameras. Try scanning on an extremely overcast day
or 2 hours before sunrise or after sunset for best results.

3) Regaining Tracking After Tracking Loss

If the tracking loss warning pops up, pause the scan. There are three possible
solutions:

@ Check for any miss scanned frames and click undo to remove them.

Aim the scanner at a previously captured area and unpause the scan. Once
the scanner has regained tracking, continue the scan.

@ If you're trying to scan a flat, featureless area, markers may need to be
placed on the surface.

® Tracking may also be lost if the object’s surface has sharp, contrasting color

differences. To fix this, pause the scan and then adjust the Depth Cameras’
exposure until the surfaces can be detected clearly.

4) Over Scanning
Repeated scanning of the same area will create more noise in the 3D model
and reduce its quality.

Once a surface area has been captured, immediately move on to the next area
to be captured to avoid over-scanning an area.

5) Scanning Small Objects’ Hard-to-reach Areas
When performing a standard scan (horizontally), there may be some very
angled areas on objects that the scanner fails to capture.

To negate this, first scan your object normally (horizontally), then turn your
scanner 90° so it's vertical and perform the scan again. Once the second scan is
finished, merge both scans.
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6) Scanning Sharp Angles and Edges

Place more markers than usually required along the edge to accurately capture
sharp angles and edges so it's easier for the scanner to track.

7) Scanning Thin Objects

Scanning thin objects is easy if you place reference objects around them for

tracking purposes.

@ Stand the thin object up vertically with some glue tack or a vice. Place at
least two reference objects, like the bust, around the object.

@ Select Feature Tracking mode and perform the scan.

® Finally, use the Clip tool to cut out the unneeded reference parts of the
scanned model.

8) Scanning People
@ Notes to the scanned person:
- Avoid wearing dark or black clothing.

+ Avoid wearing accessories such as watches, eyeglasses, necklaces, etc,
that are reflective or cause facial occlusion.

The person must remain stable when standing and avoid shaking or
breathing heavily.

* It is recommended that people with long hair tie their hair up to simply the
scan.

@ Open Revo Scan, select Feature Tracking mode, then High-accuracy Scan,
and Body for the Scan mode. Once you're in the scanning interface, adjust
the camera’s gain until there are as few red and blue patches as possible in
the preview window.

® The easiest way to start the scan is from the top center of the head. Slowly
but steadily, move in a spiral around the model, progressively descending as
you go. Ensure that you overlap the previously scanned areas as you go, as
this will help prevent tracking loss and misalignment.

@ Once you've finished the spiral, pause your scan, check it for missing parts,
and fill those in if needed. Also, don't worry about slight misalignments, as
they’ll generally be fixed automatically in Revo Scan when you fuse the
model.

9) Face Scanning

When scanning faces, remove any reflective jewelry like lip or nose studs. The
person being scanned must keep their face still during the scan, so it's
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recommended that they keep their eyes closed and not smile. During the scan,
avoid scanning in the same area repeatedly. Move the scanner along a fixed
path (from top to bottom or left to right) at a constant speed. And try to
complete the scan in one go.

For more tips, please visit youtube.com/@Revopoint3D.

6.2 Using Accessories

Some of Revopoint's accessories, like the Dual-axis Turntable or Handheld
Stabilizer, can be connected and controlled via Bluetooth in Revo Scan.

* Open Revo Scan and go to the Project Interface.
* In the menu, select Accessories, then find your accessory and click Connection.

* Find your accessory in the Bluetooth list and click connect.
For more detailed instructions, please visit revopointSd.comZpoges[support—

download and scroll down to the “Documents” section to get the accessory's
Quick Start Guide.

6.3 Feedback

If you have any question during using the software, go to the Menu Bar, and click
Help > Feedback to submit your feedback.

6.4 Software Updates

Revo Scan is frequently updated with new features and improvements. You
should keep Revo Scan up to date to ensure an optimal scanning experience.

Click the update button on the notification pop-up in Revo Scan to
automatically download the update.

6.5 Customer Service

If you need any assistance with your scanner, please don't hesitate to contact
us at customer@revopoint3d.com or drop us a line at +1 (888) 807-3339 or chat
with one of our customer service agents online on our website at
revopoint3d.com. Click the speech bubble on the bottom right corner of the
screen to access our live chat.
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7. Appendix
7.1 Troubleshooting

1. The Scanner Doesn’t Connect to a PC (Windows)

Scanner connection failure may happen for a variety of reasons. We

recommend you try the following solutions:

1) Check the connection: Make sure you use the correct cable (USB Type-A to
Type-C cable or using the USB Type-C adapter) to connect the scanner
to the computer.

2) Swap to a different USB port: Try connecting the scanner to a different USB
3.0 or better port to troubleshoot if it's a faulty port or cable.

3) Right-click on the Windows icon to enter Device Manager. Find “Camera”
and double-click it to see if the depth and RGB camera serial numbers
are displayed correctly. If the serial numbers are displayed correctly, go
to Settings > Privacy and Security, find Firewall, and allow Revo Scan
access through the Firewall.

2. The Scanner Doesn’t Connect to a PC (Mac)

1) Check the connection: Make sure you use the correct cable (USB Type-A
to Type-C cable using the USB Type-C adapter) to connect the scanner
to the computer.

2) Swap to a different Thunderbolt port: Try connecting the scanner to a
different Thunderbolt port to troubleshoot if it's a faulty port or cable.

3) check if your Mac has recognized the USB cable by clicking the Apple logo
> About This Mac > More Information > System Report > Hardware > USB.

4) Check if you have installed one of the following apps on your Mac. If you
have, ensure they are fully closed and not running in the background.
o Google drive
o Dropbox

Preview app on macOS Ventura

SmartSwitch

Garmin Express

o OneDrive

O

O

o]

3. Texture is not accessible in Revo Scan
1) The texture feature won't be accessible if Color Scans was not enabled in
the scan settings.

2) If it is a merged model, denoted by the default name Aligned_*** or
Merged_*** the Texture feature won't be accessible.

4. No Point Cloud or Image in the Preview Window
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When there is no point cloud or image in the Preview Window, try the
following solutions:

1) Check the connection: Make sure the scanner is connected. When it's
connected, the Depth Camera Preview Window will display an image.

2) Exposure settings: Ensure you have adjusted the depth camerd's
exposure settings correctly. Try adjusting the exposure setting until there
isa clear point cloud.

3) Scanning distance: Ensure the scanning distance between the scanner
and the object is good or excellent. the point cloud may not be captured
correctly if the distance is too far or too close.

4) Ambient Light: The intensity of the ambient light also affects the display of
the point cloud. Ensure the scanning environment is moderately lit to
avoid interference from too strong or too weak light.

5) Click the "Settings” button at the top right corner, toggle on or off the
"Enable GPU accelerated rendering” option, click "Save,” and then restart
Revo Scan to see if the issue is fixed.

6) If the problem remains, update your graphic card's firmware.

5. Scanning process interrupted or stuck

Stuttering or scanning interruption while scanning may be caused by the
lack of computer performance to handle a large amount of data or by a
lower software version with some bugs. You can try the following solutions:

1) Check software: Close and restart Revo Scan. If the problem remains,
update Revo Scan to the latest version to avoid bugs caused by lower
versions.

2) Upgrade computer hardware configuration, including upgrading the
processor to improve data processing capability, expanding the
computer's memory capacity, and installing solid-state drives (SSDs)
instead of traditional mechanical hard disks to improve data reading and
writing speeds.

6. Scanner Overheating Warning

A scanner overheating warning can be caused by long operation times or
high environmental temperature. If you see it, take the following actions:

1) Immediately pause and save your scan. Disconnect your 3D scanner from
the power supply and let it cool down for 30 minutes.

2) When using the scanner, ensure it has good ventilation. Revopoint
scanners’ operating environment temperature range is 0°C to 40°C (32°F

to 104°F). Please operate the product appropriately and only in situations
limited to this temperature range.
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If you're having any problems with Revo Scan or your Revopoint 3D scanner that
are not listed above, please check our website's troubleshooting section
support.revopoint3d.com/hc/en-us/sections/22024165823643-Revo-Scan-
Troubleshooting.
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7.2 Glossary

Accuracy

How closely a 3D model's dimensions match the object's.

Alignment Modes

How 3D scanners keep track of an object as they scan. See
Feature and Marker for more details.

Ambient Light

The light that comes from the surrounding environment.

Calibration Board

A board with irregularly placed dots to check or
recalibrate a 3D scanner’s accuracy.

Capture Range

The area that a 3D scanner can capture in a single frame.

Class 1Light

Light that is completely eye-safe for people and animals.

Depth cameras capture the distance and depth
information of the surrounding environment in a three-
dimensional space. They do this by measuring the light

Depth Camera spread time or reflection in a scene from infrared lights or
other technologies. It works out the distance information of
each point in the scene to construct the 3D model of the
scene.

A tracking alignment mode where 3D scanners use an

Feature Tracking |object’s features to keep track as it scans. It's used for
objects with many distinct details and surface features.

Field of View
The angular extent the cameras on a 3D scanner can see.

(Fov)

The process of merging multiple raw 3D data sets (aka

Fuse frames) created during the scan into one complete Point
Cloud that's ready for meshing or editing.

Frame The area that a 3D scanner can see and capture.
3D surfaces captured during a scanning session,

Frames collectively constituting a scan. The scan rate varies with
scanner type.

Frames per The number of frames a 3D scanner can capture in one

Second (FPS) second.
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In a computer, a file format, also called a file extension, is
the layout of a file -- in terms of how the data within the
file is organized. Revopoint products’ output file formats
are as follows:

Point cloud models can be exported in PLY, OBJ and ASC
formats.

File Format .
Mesh models can be exported in PLY, OBJ, STL, FBX, GLTF
and 3MF formats.
Texture models can be exported in PLY, OBJ, FBX and GLTF
formats.
For details of each file format, refer to the "File Formats”
section.
. A tracking mode where the 3D scanner tracks marker
Marker Tracking

stickers placed on or around.

Marker Points

Small round stickers that are usually placed on or around
flat featureless surfaces so a 3D scanner can use them as
reference points to keep track.

The process of combining separate, partial 3D scans of an

Merge .
object to create a complete 3D model.
Meshing The process of converting a Point Cloud into a 3D model.
The surface geometry of a 3D model comprises a series of
Meshes .
Vertices, Edges, and Faces.
The 3D object that results from the fusion operation (in
Model Revo Scan) or another modeling process in a different
software package.
Noise Noise is the random variation of surface points that do not
represent the true geometry of the scanned object.
Point A single point in space that has been measured and
recorded as part of a 3D point cloud.
A cloud of tiny points plotted in a 3D space. Each point
Point Cloud represents an area of an object’'s surface captured by a

3D scanner.

Point Distance

The distance between the points in a Point Cloud. The
smaller the space between the points, the higher the
resolution of the point cloud.
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Polygons

Flat geometric shapes with at least three internal angles
(e, a triangle). Polygons are the building blocks for most
3D models.

Precision

A 3D scanner's ability, over repeated scans, to provide
measurements close to one another. Usually specified as
the nominal or maximum possible difference between

two measurements of the same item.

Project

An album including the scanning configuration, raw data,
processed data, and operation history.

RGB Camera

A conventional color camera that captures and saves
image information by recording the red, green, and blue
colors of the light reflected or transmitted by the surface
of an object.

Resolution

The level of detail or precision in capturing and
representing the surface geometry of a 3D object. It is a
measure of how finely the scanner can distinguish and
capture small features, textures, and intricate details on
the scanned object.

Scan

A sequence of frames captured in a single continuous
scanner movement around an object or scene.

Scanning Speed

Typically listed as frames per second (fps) or points per
second, this is how fast a scanner can collect data per
second during a scan.

Scanning Spray

An aerosol used to lightly coat the surface of dark, shiny, or
transparent objects to help 3D scanners see them. It can
be purchased or made from everyday materials.

Single-frame

Also referred to as a frame. It's the area that a scanner
can see and capture in one frame.

A high-resolution, patterned light that deforms when

Structured Light | hitting an object's surface and allows 3D scanners to
capture surface information through its depth cameras.
Synchronizing frames of scanning data so they are

Tracking mapped to a location in 3D space that is consistent with

previous frames.
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Applying color data captured during a 3D scan that is

Texturing aligned with the mesh and applied to the model, usually
as a photographic image.
. X, Y, and Z coordinates indicate a single point in a 3D
Vertices

space.

White Balance

White balance is a camera setting that defines the color of
white. It's also called color balance or illuminant
correction. White balance adjusts images so that white
subjects appear white in the final product. It establishes a
baseline from which all other colors are measured.

Working Distance

The minimum and maximum distance a 3D scanner will
capture data when scanning an object.
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7.3 File Formats

File Format Description Applications
3D Modeling and Rendering: Commonly
used for modeling software and rendering
engines such as Maya, Blender, and 3DS
A commonly used | Max to create or edit 3D models.
3D model format for | Game Development: Commonly used in
OBJ storing the shapes | game engines such as Unity and Unreal
and textures of a 3D | Engine to import and export static 3D
model. models.
Movie Effects: Used to import and export
complex 3D scene and character models in
movie and animation production.
_ 3D Scanning Data Processing: Mostly used
A format for saving , , ,
3D scan data for storing and processing the point cloud
. . ' | data acquired from 3D scanners, especially
especially  suitable | . . .
PLY for saving point in E)CO('j.emIC reseorc.h and computer vision.
cloud data (point Scientific Research: Commonly used to
data generated by save and share 3[? data in research, such
3D scanning). as thg 3D m.odelrs in geology, archaeology,
and biomedical fields.
A format primarily | 3D Printing: Widely used in 3D printing and
used for 3D printing | rapid prototyping for manufacturing parts,
STL that records | prototypes, and models.
information  about | Industrial Design: used in the product
the triangular faces | design and development phase to produce
of a model. physical models for testing and validation.
Laser Scanning Data  Processing:
Commonly used for storing and
exchanging point cloud data captured by
A text format for|laser scanners, widely used in topographic
ASC saving point cloud | mapping, building scanning, and reverse
data generated by | engineering.
3D scanning. Photogrammetry: Used to store the 3D
point cloud data generated from images in
photogrammetry for easy data processing
and analysis.
A modern 3D | Modern 3D Printing: Provides a modern 3D
3MF printing format that | printing solution that supports colors,

saves more

materials, and textures, suitable for prints
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information  about | requiring accuracy and details.
the model, such as | Multi-Material Printing: Supports multi-
colors, materials, | material and multi-color printing, suitable
and textures. for creating complex 3D printing objects.
WebGL and Web Applications: Designed
for web delivery and 3D model display,
A format designed , Y o .p Y
, suitable for WebGL applications, virtual
for web delivery and ) . .
. reality, and augmented reality projects.
GLTF 3D model display, . . ) .
L . Online Presentation: Used for displaying
which is efficient and | . .
. . interactive 3D content on web pages, such
supports animation. ,
as 3D models of products in e-commerce
stores.
Film and TV Production: Widely used in
movie and TV special effects production,
A powerful 3D : :
. especially for scenes that require complex
modeling format . .
animation and skeletal systems.
that supports .
. . Game Development: Used to import and
complex animation . , ,
. . | export 3D models containing animation
FBX and material .
. . . .| and skeletal data in game development,
information, it is : . . ,
.| compatible with various game engines and
commonly used in
. . development tools.
film, television, and | . . . .
Virtual Reality: For virtual reality and
game development. . o .
augmented reality applications, supporting
complex animation and interactive content.
Model File . File . .
Included Files Description Notes
State | Format Types
Mesh data stored in
OBJ format,
containing a 3D
XXX_mesh OBJ File | model's geometric
data such as vertex
coordinates,
All
OoBJ normals and faces.
States ,
Point cloud data
stored in OoBJ
. format,
XXX_pC OBJ File .
representing the
point clouds in 3D
space.
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XXX _tex

JPG File

Stores the texture
images applied to a
3D model's surface
to make the model
visually real.

XXX _tex

MTL File

The material file
defines the path to
the JPG file so that it
can be applied to
the model surface.

XXX _tex

OBJ File

Contains a model's
texture coordinates
and other
geometric data.

Are used
together to
load and
render 3D
models

properly

PLY

XXX_mesh

PLY File

Mesh data stored in
PLY format,
containing a 3D
model's geometric
data such as vertex
coordinates,
normals and faces.

XXX_C

PLY File

Point cloud data
stored in PLY format,
representing the
point clouds in 3D
space.

XXX _tex

JPG File

Stores the texture
images applied to a
3D model's surface
to make the model
visually real.

XXX _tex

PLY File

Contains a model’s
texture coordinates
and other
geometric data.

Are used
together to
load and
render 3D
models

properly

Point
Clouds

ASC

XXX_pc.asc

ASC File

Point cloud data
stored in ASCII
format.

OBJ

XXX_C

OBJ File

Point cloud data
stored in OBJ
format.
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PLY

XXX_C

PLY File

Point cloud data
stored in PLY format.

Mesh
Models

3MF

xxX_mesh.3mf

3MF File

Mesh data stored in
3MF format,
containing a 3D
model's geometry,
color, and other
data. It's a file
format used for 3D
printing.

FBX

XXX_mesh

FBX File

Mesh data stored in
FBX format,
containing a 3D
model's geometry,
color, and other
data. It's a file
format used for 3D
modeling,
animation, and
visual effects.

GLTF

XXX_mesh.bin

BIN File

Stores the binary
data related to a
model, such as
vertex coordinates,
normals, etc.

xxX_mesh.gltf

GLTF File

Describes the
structure and
properties of a
model, as well as
reading and
opening BIN files. It's
a file format used to
transfer and load
3D models.

Are used
together to
load and
render 3D
models

properly

OBJ

XXX_mesh

OBJ File

Mesh data stored in
OBJ format.

PLY

XXX_mesh

PLY File

Mesh data stored in
PLY format.

STL

XXX_mesh

STL File

Mesh data stored in
STL format.
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Texture
Models

Contains a 3D

model's geometry
and texture datag, a
XXX _tex FBX File | file format used for | Are used
3D modeling, | together to
animation and | load and
FBX .
visual effects. render 3D
Stores the texture models
images applied to a | properly
XXX _tex JPG File | 3D model's surface
to make the model
visually real.
Describes the
structure and
properties of a
model, as well as
xxx _tex.gltf GLTF File | reading and
opening BIN files. It's
a file format used to
transfer and load | Are used
3D models. together to
GLTE Stores the binary | load and
data related to a | render 3D
. . model, such as models
Xxx_tex.bin BIN File )
vertex coordinates, | properly
normals, texture
coordinates, etc.
Stores the texture
images applied to a
XXX _tex JPG File | 3D model's surface
to make the model
visually real.
Contains a model’s
) texture coordinates
XXX _tex OBJ File Are used
and other
. together to
geometric data. load and
OBJ The material file| render 3D
defines the path to models
XXX _tex MTLFile | the JPG file so thatit | properly

can be applied to
the model surface.
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Stores the texture
images applied to a
Xxx_tex JPG File | 3D model's surface
to make the model

visually real.

Contains a model’s
texture coordinates

XXX _tex PLY File Are used
and other
. together to
geometric data.
load and
PLY Stores the texture
. lied t render 3D
images a ied to a
) g F,)p models
XXX _tex JPG File 3D model's surface
properly
to make the model
visually real.

Notes

1. In each included file, ‘'mesh” means a mesh model, "pc" means a
point cloud model, and "tex’ means a texture model.

2. The material properties data contained in the MTL file is not
available in the current version of Revo Scan.

3. Please avoid saving multiple files in different formats to the same
directory.
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7.4 Keyboard Shortcuts

Function Windows Shortcut macOS Shortcut
Back to Orbit (exit selection
mode) v v
Rectangular Selection M M
Polygon Selection L L
Lasso Selection U U
Clip C C
Select All Ctrl+A Command+A
Invert Selection Ctrl+Shift+ Command+Shift+l
Delete Backspace Backspace
Undo Ctrl+z Command+Z
Redo Ctrl+Y Command+Y
New Project Ctrl+N Command+N
Open Project Ctrl+O Command+0O
Save Ctrl+S Command+S
Import Ctrl+l Command+|
Set Pivot Point Alt+Left-click Option+Left-click

Zoom In/Out

Mouse Scroll Wheel or Two
Fingered Pinch In & Out

Mouse Scroll Wheel or Two
Fingered Pinch In & Out

Move

Shift+Left-click

Shift+Left-click

Rotate in Selection Mode

Ctrl+Left-click

Command+Left-click

Zoom to Fit

Ctrl+D

Command+D

Default View

Space

Space

Select Through

Ctrl+Shift+T

Command+Shift+T

Select Connection

B

B

Reduce Selection

Ctrl+Shift+Selction

Command+Shift+Selection

Full Screenshot Ctrl+Shift+A Command+Shift+A
Model Only Screenshot Ctrl+Shift+M Command+Shift+M
Ctrl+L Command+L

Light Source
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